
CHÖÔNG III. 
ÑAÊNG KYÙ BAÛN ÑOÀ QUEÙT VAØO MAPINFO

III.1. CHUAÅN BÒ BAÛN ÑOÀ

Tröôùc heát baûn ñoà caàn soá hoaù phaûi ñöôïc chuyeån thaønh aûnh treân maùy tính baèng maùy
queùt (scanner). AÛnh queùt vaøo maùy tính seõ ñöôïc xöû lyù laïi cho roõ neùt vaø chính xaùc baèng
phaàn meàm xöû lyù aûnh. Neáu tôø baûn ñoà quaù lôùn maø ta chæ coù maùy queùt nhoû thì phaûi queùt
nhieàu laàn vaø raùp aûnh laïi trong phaàn meàm xöû lyù aûnh. AÛnh xöû lyù xong neân ñöôïc löu laïi
döôùi moät trong nhöõng ñònh daïng aûnh maø MapInfo hoã trôï. MapInfo hoã trôï nhöõng ñònh
daïng aûnh sau:

- MrSID: aûnh ñònh daïng MrSID, ñuoâi môû roäng .sid. Neáu coù caøi ñaët trình ñieàu khieån aûnh
naøy (MrSID raster Handler) treân MapInfo thì môùi môû ñöôïc aûnh ñònh daïng naøy.

- Windows Bitmap: laø aûnh ñònh daïng chuaån cuûa heä ñieàu haønh Window, ñuoâi môû roäng
.bmp. MapInfo hoã trôï caùc cheá ñoä aûnh traéng-ñen (monochrome), aûnh 8 bit maøu vaø
aûnh 24 bit maøu.

- GIF: laø ñònh daïng aûnh cuûa Graphics Interchange Format, ñuoâi môû roäng .gif. MapInfo
hoã trôï caùc ñònh daïng traéng-ñen vaø 8 bit maøu.

- JPEG: chuaån neùn aûnh cuûa Joint Photographic Experts, ñuoâi môû roäng laø .jpg. MapInfo
hoã trôï chuaån naøy caùc cheá ñoä aûnh 8 bit thang maøu xaùm vaø 24 bit maøu.

- PCX: laø chuaån aûnh soá cuûa ZSoft Paintbrush, ñuoâi môû roäng cuûa aûnh laø .pcx. Loaïi aûnh
naøy ñöôïc MapInfo hoã trôï caùc cheá ñoä maøu traéng-ñen, 8 bit thang maøu xaùm, 8 bit maøu
vaø 24 bit maøu.

- SPOT: laø chuaån aûnh veä tinh cuûa Phaùp (Satellite Pour ‘Observation de la Terre), ñuoâi
môû roäng .bil. Chuaån naøy ñöôïc MapInfo hoã trôï caùc cheá ñoä maøu sau: 8 bit thang maøu
xaùm vaø 24 bit maøu (ñònh daïng 1.5 vaø 4.0).

- TGA: laø chuaån aûnh soá cuûa Targa True Vision TGA, chuaån ñònh daïng 2.0 ñuoâi môû
roäng laø .tga. Caùc cheá ñoä maøu 8 bit thang maøu xaùm, 8 bit maøu vaø 24 bit maøu ñöôïc
MapInfo hoã trôï.

- TIFF: chuaån aûnh soá cuûa Tagged Image File Format, ñuoâi môû roäng laø .tif. Caùc cheá ñoä
aûnh sau cuûa TIFF ñöôïc MapInfo hoã trôï: traéng ñen (nhoùm B, khoâng neùn), traéng-ñen
(nhoùm B, neùn theo chuaån PackBits), 8 bit thang maøu xaùm (nhoùm G, khoâng neùn), 8
bit thang maøu xaùm (nhoùm G, neùn theo chuaån LZW), 8 bit maøu (nhoùm P, khoâng
neùn), 8 bit maøu (nhoùm P, neùn theo chuaån LZW), 24 bit maøu (nhoùm R, khoâng neùn),
24 bit maøu (nhoùm R, neùn theo chuaån LZW).
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Neáu khoâng coù yù ñònh xöû lyù aûnh theâm vaø chæ söû duïng nhaèm muïc ñích soá hoaù treân
MapInfo thì ta coù theå löu aûnh ôû ñònh daïng JPEG vì kích thöôùc töông ñoái nhoû. Veà maët
nguyeân taéc, aûnh queùt coù theå ñeå ôû baát kyø vò trí naøo; khi ñaêng kyù toïa ñoä baèng caùc ñieåm
khoáng cheá MapInfo seõ chænh baûn ñoà ñöôïc soá hoaù treân neàn aûnh queùt ñoù laïi cho ñuùng
toïa ñoä. Tuy nhieân toát nhaát laø neân quay baûn ñoà ñuùng theo höôùng baéc nam, vì neáu baûn
ñoà queùt hôi leäch thì MapInfo khoâng caân chænh ñöôïc nhöõng sai soá nhoû naøy.

III.2. XAÙC ÑÒNH CAÙC ÑIEÅM KHOÁNG CHEÁ (Control Points)

Muoán hieån thò ñöôïc aûnh ñuùng tyû leä vaø ñuùng toaï ñoä ñòa lyù trong MapInfo, ta caàn bieát
toïa ñoä cuûa ít nhaát 3 ñieåm treân baûn ñoà vaø naïp toïa ñoä cuûa caùc ñieåm ñoù ñeå MapInfo duøng
chuùng laøm cô sôû tính toaùn toïa ñoä, khoaûng caùch, dieän tích,... sau naøy. Soá löôïng ñieåm
khoáng cheá toái thieåu laø 3 nhöng toát nhaát neân naïp töø 4 ñieåm trôû leân vì vôùi 4 ñieåm MapInfo
seõ tính toaùn ñöôïc sai soá (tính baèng pixel - ñieåm aûnh). Ñoái vôùi caùc baûn ñoà giaáy chuaån
do nhaø xuaát baûn baûn ñoà in, ta coù theå laáy caùc ñieåm khoáng cheá coù saün treân baûn ñoà. Vieäc
xaùc ñònh caùc ñieåm khoáng cheá tuyø thuoäc vaøo töøng loaïi baûn ñoà.

Ghi chu ù: Khi choïn caùc ñieåm khoáng cheá,
caàn choïn caùc ñieåm caøng xa nhau caøng toát
(vì MapInfo seõ tính toaùn chính xaùc hôn)
ñoàng thôøi phaûi coù ít nhaát moät ñieåm naèm
gaàn meùp baûn ñoà.

III.3. ÑAÊNG KYÙ AÛNH QUEÙT

Ta seõ söû duïng moät taäp tin aûnh queùt ôû
ñaây laø baûn ñoà ranh giôùi nöôùc Vieät Nam,
taäp tin Vietnam.jpg, ñeå laøm ví duï. Treân aûnh
queùt naøy ta seõ söû duïng 4 ñieåm ñaõ bieát toïa
ñoä ñeå laøm ñieåm khoáng cheá (hình III.1).

Toïa ñoä 4 ñieåm naøy nhö sau: 
1: (100o00'00'' E, 25o00'00'' N);
2: (107o30'00'' E, 22o30'00'' N);
3: (110o00'00'' E, 07o30'00'' N);
4: (102o30'00'' E, 10o00'00'' N)

Caùc toïa ñoä treân caàn ñöôïc ñoåi veà ñoä
thaäp phaân tröôùc khi ñaêng kyù.

- Khôûi ñoäng chöông trình MapInfo, trong
hoäp thoaïi Quick Start choïn Open a Table.
Neáu ñaõ nhaán Cancel trong hoäp thoaïi naøy
khi khôûi ñoäng MapInfo thì töø menu chính
choïn File > Open Table.

- Trong oâ Files of type ta choïn Raster
Image, vaøo thö muïc coù taäp tin Vietnam.jpg
ñeå choïn noù, xong choïn Open (hình III.2).Hình III.1. Baûn ñoà Vieät Nam vôùi 4 ñieåm

ñaõ bieát toaï ñoä.
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MapInfo hieån thò hoäp thoaïi hoûi hieån
thò aûnh (Display) hay ñaêng kyù aûnh
(Register), ta choïn Register (hình
II.3).

- Hoäp thoaïi Image Registration seõ môû
ra vaø baûn ñoà queùt ñöôïc hieån thò
(hình III.4). Coù theå phoùng to hay
thu nhoû aûnh baèng hai nuùt vaø

, coù theå di chuyeån aûnh baèng hai
thanh cuoän ngang vaø ñöùng.

- Choïn Heä quy chieáu: ñaây laø böôùc raát quan troïng trong ñaêng kyù aûnh vì neáu choïn sai
thì caùc taäp tin soá hoaù sau naøy caên cöù treân aûnh queùt seõ khoâng chính xaùc vaø trong
nhieàu tröôøng hôïp baûn ñoà sau khi soá hoaù xong luùc môû ra seõ bò meùo. Khi ñaêng kyù moät
baûn ñoà queùt, ta phaûi bieát heä quy chieáu cuûa tôø baûn ñoà ñoù. Caùc thoâng tin veà heä quy
chieáu thöôøng coù treân baûn ñoà, caàn chuù yù xem ñeå choïn heä quy chieáu cho ñuùng. Xem
theâm veà heä quy chieáu trong Chöông XIX. Nhaán chuoät vaøo nuùt Projection, hoäp thoaïi
Choose Projection (choïn heä quy chieáu) môû ra (hình III.5). Neáu khoâng bieát heä quy
chieáu maø laïi coù toaï ñoä caùc ñieåm khoáng cheá tính baèng kinh ñoä/vó ñoä thì ta coù theå choïn
Longitude/Latitude (WGS84).
Trong ví duï naøy ta choïn trong oâ Category laø Longitude/Latitude vaø trong Category
Members laø Longitude/Latitude (WGS84). Xong nhaán OK. Nhaép chuoät vaøo nuùt Units
(ñôn vò). Trong tröôøng hôïp naøy ñôn vò maëc ñònh laø degrees (ñoä - vieát taét laø deg). Ñoái
vôùi moät soá heä quy chieáu khaùc, ta coù theå coù tuyø choïn nhieàu ñôn vò toïa ñoä khaùc nhau.
Choïn ñôn vò xong nhaép chuoät vaøo OK ñeå quay trôû laïi hoäp thoaïi Image Registration.

- Naïp toïa ñoä caùc ñieåm khoáng cheá: khi di chuyeån chuoät treân phaàn baûn ñoà, con troû
chuoät bieán thaønh hình daáu coäng. Di chuyeån chuoät ñeán ñieåm khoáng cheá thöù nhaát vaø

Hình III.3. Thoâng baùo hoûi
ñaêng kyù taäp tin aûnh

Hình III.2. Hoäp thoaïi Open Table - choïn môû taäp tin aûnh
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nhaép chuoät, hoäp thoaïi Add Control Point (naïp ñieåm khoáng cheá) môû ra (hình III.6).
Naïp toïa ñoä cuûa ñieåm thöù nhaát vaøo trong hai oâ MapX (kinh ñoä) vaø MapY (vó ñoä). Löu
yù raèng toïa ñoä naïp vaøo trong hai oâ naøy laø ñoä thaäp phaân chöù khoâng phaûi ñoä - phuùt -
giaây. Ta phaûi ñoåi caùc toïa ñoä veà ñoä thaäp phaân tröôùc khi naïp toïa ñoä. Khoâng caàn thay
ñoåi gì trong hai oâ ImageX vaø ImageY vì ñaây laø toaï ñoä cuûa aûnh queùt tính baèng pixel
do MapInfo töï tính vaø naïp vaøo.

Coù theå ñaët teân cho ñieåm khoáng cheá baèng caùch goõ teân vaøo oâ Label, neáu khoâng

MapInfo töï ñoäng ñaët teân cho caùc ñieåm khoáng cheá theo thöù töï laø Pt1, Pt2, Pt3, (Pt -
vieát taét cuûa chöõ point - ñieåm).

Chuù yù: MapInfo quy öôùc höôùng toïa ñoä theo daáu, neáu toaï ñoä ta naïp vaøo laø kinh ñoä
Taây vaø vó ñoä Nam thì con soá phaûi coù daáu tröø ñaèng tröôùc (laø soá aâm). Nöôùc Vieät Nam
naèm hoaøn toaøn trong vuøng phía Ñoâng vaø treân ñöôøng xích ñaïo (vó ñoä Baéc) neân baûn
ñoà trong ranh giôùi nöôùc ta khi naïp toaï ñoä khoâng caàn daáu (soá döông).

- Naïp xong toïa ñoä ta nhaán OK, quay trôû laïi hoäp thoaïi ñaêng kyù aûnh. Ñieåm nhaép chuoät
ñöôïc ñaùnh daáu baèng daáu coäng maøu ñoû vaø coù teân cuûa ñieåm ñoù beân caïnh.

- Di chuyeån chuoät treân baûn ñoà ñeå tìm caùc ñieåm khoáng cheá coøn laïi vaø naïp toïa ñoä cuûa
chuùng vaøo töông töï nhö vôùi ñieåm ñaàu tieân.

Hình III.4. Hoäp thoaïi Image Registration - ñaêng kyù aûnh
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Löu yù raèng neáu ta chæ
naïp 3 ñieåm khoáng cheá thì
sai soá ñaêng kyù aûnh luoân
luoân laø 0 pixel duø ta chaám
caùc ñieåm sai hoaëc naïp sai
toaï ñoä. Neáu naïp töø 4 ñieåm
khoáng cheá trôû leân thì môùi
coù theå bieát ñöôïc sai soá.

Trong ví duï naøy ta naïp
4 ñieåm khoáng cheá. Coù theå
thaáy maøn hình ñaêng kyù vôùi
danh saùch 4 ñieåm, toïa ñoä
cuûa töøng ñieåm vaø sai soá
trong coät Error (pixels)
(hình III.7).

Sai soá trong ñaêng kyù
aûnh coù theå do caùc nguyeân

nhaân sau:

- AÛnh queùt khoâng chính xaùc (bò meùo hoaëc
gheùp aûnh khoâng chính xaùc). Chaát löôïng cuûa
tôø baûn ñoà queùt vaøo cuõng raát quan troïng.

- Naïp toïa ñoä sai.

- Chaám ñieåm khoáng cheá sai.

Ta coù theå choïn moät ñieåm khoáng cheá baèng
caùch nhaép chuoät vaøo ñieåm muoán choïn treân
danh saùch caùc ñieåm ñoù. Ta cuõng coù theå xem vò
trí ñieåm khoáng cheá treân baûn ñoà baèng caùch choïn
moät ñieåm trong danh saùch ôû coät Label roài nhaép
chuoät vaøo nuùt Goto, coù theå chænh söûa laïi ñieåm
khoáng cheá baèng nuùt Edit, coù theå xoaù boû moät
ñieåm khoáng cheá baèng nuùt Remove, coù theå theâm
ñieåm khoáng cheá baèng nuùt New.

Thoâng thöôøng thì khoù coù theå traùnh khoûi sai
soá neáu naïp nhieàu ñieåm khoáng cheá. Tuy nhieân
ta phaûi xaùc ñònh sai soá bao nhieâu laø chaáp nhaän
ñöôïc. Sai soá chaáp nhaän ñöôïc laïi phuï thuoäc vaøo
nhu caàu söû duïng, tyû leä baûn ñoà ñaêng kyù vaø hoaøn
toaøn do ngöôøi ñaêng kyù quyeát ñònh. Ví duï neáu ta queùt baûn ñoà nöôùc Vieät Nam tyû leä
1/1.000.000 maø sai soá laø 10 km thì coù theå chaáp nhaän ñöôïc (vì laø moät baûn ñoà ñaïi
cöông, tyû leä raát nhoû) nhöng neáu ta queùt moät baûn ñoà Gauss tyû leä 1/10.000 maø sai soá
laø 500 meùt thì khoâng theå chaáp nhaän  ñöôïc (vì laø moät baûn ñoà coù ñoä chính xaùc cao).

Sai soá baùo treân hoäp thoaïi ñaêng kyù aûnh queùt ñöôïc tính baèng pixel. Ta phaûi quy ñoåi
veà ñôn vò ño löôøng thoâng thöôøng (meùt, kiloâmeùt,...) ñeå bieát sai soá ñoù coù chaáp nhaän ñöôïc
hay khoâng. Xem caùch tính sai soá ôû phaàn sau cuûa chöông naøy.

Hình III.6. Hoäp thoaïi Add Control
Point - naïp toïa ñoä cho ñieåm
khoáng cheá

Hình III.5. Hoäp thoaïi Choose Projection
- choïn heä quy chieáu.
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- Sau khi naïp xong caùc ñieåm khoáng cheá, ta nhaán OK. MapInfo seõ môû aûnh queùt ra
trong cöûa soå baûn ñoà.

Khi ñaêng kyù xong, MapInfo seõ töï taïo ra
moät taäp tin chöùa caùc thoâng tin maø ta ñaõ
ñaêng kyù toaï ñoä cho aûnh queùt. Taäp tin naøy

coù cuøng teân vôùi taäp tin aûnh maø ta ñaõ ñaêng
kyù vôùi ñuoâi môû roäng laø .tab (ñöôïc goïi laø
MapInfo Table). Neáu nhìn treân cöûa soå
Window Explorer cuûa heä ñieàu haønh ta seõ
thaáy taäp tin naøy ñöôïc löu laïi trong cuøng
thö muïc vôùi taäp tin aûnh queùt.

Laàn sau khi muoán môû laïi taäp tin aûnh ñaõ ñaêng kyù thì chæ caàn choïn Open Table trong
menu File (hay Open a Table trong hoäp thoaïi Quick Start), taäp tin .tab laø taäp tin ta seõ
thaáy, choïn noù roài nhaép chuoät vaøo nuùt Open thì taäp tin aûnh ñaõ ñaêng kyù seõ ñöôïc môû ra,
khoâng caàn phaûi ñaêng kyù aûnh queùt laïi nöõa.

Hình III.7. Baûn ñoà sau khi ñaêng kyù xong 4 ñieåm toaï ñoä vaø sai soá hieån
thò treân coät Error (pixels)
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III.4. ÑAÊNG KYÙ AÛNH QUEÙT KHI KHOÂNG BIEÁT TOAÏ ÑOÄ

Ñoâi khi ta cuõng coù nhu caàu xöû lyù moät baûn ñoà trong MapInfo maø khoâng bieát toaï ñoä.
Hoaëc cuõng coù theå ta muoán xöû lyù moät baûn ñoà khoâng lieân quan ñeán toaï ñoä ñòa lyù treân beà
maët quaû ñaát, ví duï nhö baûn veõ moät loâ ñaát chaúng haïn. Trong tröôøng hôïp ñoù ta vaãn coù
theå ñaêng kyù moät baûn ñoà queùt khoâng coù toaï ñoä vaøo MapInfo ñeå soá hoaù vaø söû duïng caùc
leänh cuûa MapInfo. Moät baûn ñoà khoâng bieát toaï ñoä hoaëc khoâng caàn toaï ñoä khi ñaêng kyù
vaøo MapInfo cuõng phaûi bieát tyû leä thì caùc tính toaùn ñòa lyù môùi chính xaùc ñöôïc. Moät baûn
ñoà trong MapInfo khoâng söû duïng heä toaï ñoä quaû ñaát thì heä toaï ñoä noù söû duïng ñöôïc goïi
laø heä toaï ñoä phi quaû ñaát (Non-Earth). Khi ñaêng kyù baûn ñoà theo heä kinh ñoä/vó ñoä,
MapInfo seõ caên cöù treân caùc ñieåm khoáng cheá ñeå hieån thò aûnh queùt cho ñuùng vôùi heä toaï
ñoä ñöôïc choïn. Ñoái vôùi aûnh queùt ñaêng kyù khoâng theo heä kinh/vó ñoä, ta caàn hieåu bieát ñoâi
chuùt veà aûnh queùt ñeå ñaêng kyù cho ñuùng.

III.4.1. Sô löôïc veà aûnh queùt trong maùy tính

AÛnh queùt trong maùy tính khaùc vôùi aûnh giaáy bình thöôøng. Moät aûnh queùt trong maùy
tính thöïc chaát bao goàm nhieàu ñieåm nhoû hình vuoâng goïi laø pixel - ñieåm aûnh (vieát taét cuûa
chöõ picture element). Moãi moät ñieåm aûnh coù moät maøu xaùc ñònh. Soá maøu cuûa moät aûnh
queùt tuyø thuoäc vaøo ñònh daïng cuûa aûnh queùt ñoù. Ví duï aûnh thang ñoä xaùm 8 bit seõ coù
256 caáp ñoä xaùm (28 = 256) töø maøu traéng ñeán maøu ñen, aûnh maøu 24 bit seõ coù 224 =
16777216 maøu (hôn 16,7 trieäu maøu). Maùy tính quaûn lyù aûnh queùt theo töøng ñieåm aûnh

Hình III.8. Hình A, aûnh con
caù treân maùy tính troâng
bình thöôøng; hình B: khi
phoùng to aûnh ra (phaàn ñaàu
caù), aûnh thöïc chaát laø taäp hôïp
nhöõng hình vuoâng nhoû (ñieåm aûnh), moãi
hình vuoâng coù moät maøu xaùc ñònh vaø vò trí xaùc ñònh.

Hình III.9. A: Heä toaï ñoä
cuûa aûnh queùt vaø
B: heä toaï ñoä phi
quaû ñaát trong
MapInfo (heä toaï
ñoä Descartes).
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vaø giaù trò maøu cuûa ñieåm aûnh ñoù. Khi quan saùt moät aûnh queùt treân maùy tính, vì kích thöôùc
ñieåm aûnh quaù nhoû neân ta khoâng nhìn thaáy caùc ñieåm aûnh. Nhöng neáu phoùng to aûnh

queùt ra thì ta seõ nhìn thaáy nhöõng ñieåm aûnh naøy
(hình III.8).

Moãi ñieåm aûnh treân aûnh queùt seõ
coù 3 thoâng soá, toaï ñoä cuûa ñieåm

aûnh ñoù theo truïc x vaø y vaø giaù trò
maøu cuûa ñieåm aûnh ñoù. Toaï ñoä
cuûa ñieåm aûnh laø vò trí cuûa ñieåm
aûnh ñoù treân aûnh, töùc ñieåm
aûnh ñoù naèm ôû haøng thöù maáy
vaø coät thöù maáy. Goác toaï ñoä
cuûa aûnh naèm ôû goùc treân beân
traùi cuûa taám aûnh. Trong heä
toaï ñoä cuûa aûnh queùt chieàu
döông cuûa truïc tung (truïc y)

laø chieàu töø treân xuoáng, coøn
chieàu döông cuûa truïc hoaønh

(truïc x) laø chieàu töø traùi sang
phaûi. Trong khi ñoù heä toaï ñoä phi

quaû ñaát trong MapInfo laïi laáy goác
toaï ñoä laø goùc döôùi beân traùi. Vì vaäy truïc

Y trong aûnh queùt vaø truïc Y trong
MapInfo coù chieàu ngöôïc nhau (hình
III.9). 

Khi ñaêng kyù aûnh queùt coù toaï ñoä theo heä toaï ñoä cuûa Traùi ñaát (kinh ñoä/vó ñoä), ta phaûi
söû duïng moät trong nhöõng heä quy chieáu ñöôïc MapInfo hoã trôï. Trong heä toaï ñoä theo kinh
ñoä/vó ñoä cuûa quaû ñaát, goác toaï ñoä 0 laø giao ñieåm cuûa ñöôøng kinh tuyeán goác vaø ñöôøng
xích ñaïo (hình III.10). Ñöôøng kinh tuyeán goác laø truïc Y vaø ñöôøng xích ñaïo laø truïc X.
Chieàu döông cuûa vó  ñoä laø chieàu höôùng leân treân (höôùng baéc) vaø chieàu döông cuûa kinh
ñoä laø chieàu höôùng sang phaûi (höôùng ñoâng).

Khi ñaêng kyù aûnh queùt khoâng coù toaï ñoä, MapInfo söû duïng heä truïc toaï ñoä Descartes
vôùi chieàu cuûa truïc tung vaø truïc hoaønh cuõng gioáng vôùi chieàu cuûa heä toaï ñoä kinh/vó ñoä.

Do heä toaï ñoä cuûa aûnh queùt vaø heä toaï ñoä phi quaû ñaát (Non-Earth) maø MapInfo söû
duïng coù truïc tung ngöôïc chieàu nhau vì vaäy khi ñaêng kyù aûnh queùt ta phaûi ñoåi daáu giaù
trò y cuûa caùc ñieåm khoáng cheá.

III.4.2. Caùch ñaêng kyù

AÛnh queùt ñaêng kyù theo heä toaï ñoä phi quaû ñaát cuõng phaûi bieát tyû leä thì môùi ñaêng kyù
ñuùng ñöôïc. Ta coù theå söû duïng ngay heä toaï ñoä cuûa Photoshop ñeå laáy toaï ñoä cuûa caùc
ñieåm khoáng cheá, sau ñoù quy ñoåi chuùng ra khoaûng caùch treân thöïc ñòa baèng caùch nhaân
vôùi tyû leä cuûa baûn ñoà. Khi naïp toaï ñoä caùc ñieåm khoáng cheá trong hoäp thoaïi Image
Registation cuûa MapInfo, ta ñoåi daáu giaù trò Y (töùc truïc tung). Neáu khoâng ñoåi daáu, do cheá
ñoä hieån thò cuûa aûnh queùt trong MapInfo bò phuï thuoäc vaøo aûnh queùt vì theá ta khoâng thaáy
aûnh queùt bò ngöôïc chieàu. Nhöng khi soá hoaù treân aûnh queùt naøy vaø chæ môû baûn ñoà ñaõ soá
hoaù thì baûn ñoá soá seõ bò laät ngöôïc. Nhöõng baûn ñoà soá nhö vaäy khoâng theå chænh söûa ñöôïc.

Hình III.10. Heä truïc toaï ñoä cuûa quaû ñaát.
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Ta seõ xem xeùt moät ví duï döôùi ñaây.

Ta coù moät aûnh queùt laø baûn ñoà quy hoaïch söû duïng ñaát quaän 4 ñeán naêm 2005, tyû leä
1/28.000, taäp tin coù teân laø Quan4_2005.jpg. Caùc böôùc thöïc hieän ñaêng kyù nhö sau:

1- Khôûi ñoäng phaàn meàm Photoshop vaø môû aûnh queùt ra.

2- Baät thöôùc ño ngang vaø ñöùng cuûa Photoshop leân neáu chöa baät. Caùch laøm: töø menu
chính cuûa Photoshop choïn View > Show Ruler.

3- Chuyeån thöôùc ño treân Photoshop thaønh centimet. Caùch laøm: töø menu chính choïn
Edit > Preferences > Units and Rulers. Hoäp thoaïi Preferences môû ra.

4- Trong oâ Units, ôû phaàn Rulers, ñoåi ñôn vò ño thaønh cm.

5- Choïn tröôùc treân tôø baûn ñoà queùt nhöõng ñieåm naøo ñöôïc söû duïng laøm ñieåm khoáng
cheá. Nguyeân taéc choïn ñieåm khoáng cheá trong tröôøng hôïp naøy cuõng gioáng nhö khi
ñaêng kyù theo kinh ñoä/vó ñoä. Ta neân choïn toái thieåu laø 4 ñieåm ñeå thaáy ñöôïc sai soá.

6- Baät cöûa soå baùo toaï ñoä vò trí con troû chuoät leân, caùch laøm: töø menu chính choïn
Window > Show Info.

7- Nhaép chuoät choïn coâng cuï Rectangular Marquee Tool .

8- Di chuyeån chuoät trôû laïi aûnh queùt. Con troû chuoät bieán thaønh hình daáu coäng. Khi di
chuyeån chuoät trong aûnh queùt, treân hai thöôùc ño ngang vaø ñöùng hieän ra hai ñöôøng
chaám chaám maûnh cho ta bieát toaï ñoä vò trí con troû chuoät. Ñoàng thôøi treân cöûa soå
Info, goùc döôùi beân traùi cuõng hieän ra hai giaù trò X vaø Y cho ta bieát chính xaùc toaï ñoä
cuûa con troû.

9- Di chuyeån con troû chuoät ñeán ñieåm khoáng cheá thöù nhaát, ghi laïi toaï ñoä X vaø Y cuûa
vò trí ñoù treân cöûa soå Info.

10- Töông töï, di chuyeån chuoät ñeán taát caû caùc vò trí ñaõ choïn laøm ñieåm khoáng cheá vaø
laàn löôït ghi laïi caùc caëp toaï ñoä (X,Y) cuûa caùc ñieåm ñoù. Laøm xong ñoùng taäp tin aûnh
laïi vaø thoaùt khoûi Photoshop.

Giaû söû ta ñaõ choïn boán ñieåm khoáng cheá coù caùc toaï ñoä nhö sau:

ñieåm 1: (x= 1.67, y =1.57); ñieåm 2: (x = 16.48, y = 2.58); ñieåm 3: (x = 16.94, y =
9.22); ñieåm 4: (x = 5.2, y = 7.55). Vì thöôùc tyû leä ta choïn ôû ñaây laø cm neân caùc giaù
trò toaï ñoä ôû ñaây ñöôïc tính baèng centimeùt.

Ta tieán haønh quy ñoåi caùc toaï ñoä naøy veà kích thöôùc treân thöïc ñòa. Caùch laøm:

11- Baûn ñoà naøy coù tyû leä laø 1:28,000 vaäy 1cm = 28,000 cm = 0.28 km treân thöïc ñòa.
Nhö vaäy toaï ñoä treân aûnh cuûa ñieåm 1 laø (1.67,1.57) (cm) neân toaï ñoä cuûa ñieåm ñoù
tính theo tyû leä thöïc ñòa seõ laø x = 1.67 x 0.28 vaø y = 1.57 x 0.28, töùc laø (x = 0.4676,
y = 0.4396) (km). Töông töï nhö vaäy ta tính laïi toaï ñoä caùc ñieåm khoáng cheá theo tyû
leä thöïc. Keát quaû laø caùc ñieåm khoáng cheá seõ coù toaï ñoä thöïc nhö sau:

ñieåm 1: (x= 0.4676, y =0.4396); ñieåm 2: (x = 4.6144, y = 0.7224); ñieåm 3: (x =
4.7432, y = 2.5816); ñieåm 4: (x = 1.456, y = 2.114).

Sau khi ñaõ coù toaï ñoä cuûa 4 ñieåm khoáng cheá treân thöïc ñòa, ta tieán haønh ñaêng kyù
toaï ñoä vaøo MapInfo nhö sau:

12- Khôûi ñoäng MapInfo.
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13- Töø hoäp thoaïi Quick Start choïn Open a Table hay töø menu chính choïn File > Open
Table. Hoäp thoaïi Open Table môû ra.

14- Trong hoäp thoaïi môû baûng, ôû oâ File of Type choïn Raster Image, trong oâ Look in,
môû thö muïc ñaõ löu taäp tin aûnh queùt Quan4_2005.jpg vaø choïn taäp tin naøy roài nhaép
chuoät choïn Open. Hoäp thoaïi hoûi ñaêng kyù aûnh môû ra.

15- Choïn Register. Hoäp thoaïi Image Registration môû ra.

16- Nhaép chuoät choïn nuùt Projection, hoäp thoaïi Choose Projection môû ra.

17- Trong oâ Category nhaép chuoät vaøo nuùt thaû xuoáng choïn Non-Earth; ôû döôùi oâ
Category Members choïn Non-Earth (kilometers) (vì toaï ñoä ta tính ôû phaàn treân theo
kiloâmeùt). Xong choïn OK ñeå quay laïi hoäp thoaïi Image Registration. Neáu nhaép chuoät
vaøo nuùt Units ta seõ thaáy ñôn vò tính seõ ñöôïc ñoåi thaønh kilometers.

18- Duøng hai thanh cuoän ngang vaø ñöùng ñeå di chuyeån baûn ñoà ñeán ñieåm ñaêng kyù thöù
nhaát. Coù theå phoùng to hay thu nhoû baûn ñoà ñeå thaáy roõ.

Thoâng thöôøng ta neân phoùng to baûn ñoà ñeå chaám ñieåm
khoáng cheá cho chính xaùc.

19- Nhaép chuoät vaøo vò trí ñieåm khoáng cheá thöù nhaát. Hoäp
thoaïi Add Control Point môû ra.

20- Naïp toaï ñoä x vaø y cuûa ñieåm khoáng cheá thöù nhaát vaøo
oâ MapX vaø MapY. Nhö ñaõ trình baøy, truïc toaï ñoä Y trong

aûnh queùt vaø MapInfo ngöôïc chieàu nhau neân phía tröôùc giaù
trò y ta phaûi goõ daáu tröø (-) ñeå ñoåi chieàu laïi theo MapInfo.
Daáu tröø phaûi naèm saùt vaøo con soá chöù khoâng ñöôïc caùch ra.

Laøm xong choïn OK.

21- Di chuyeån baûn ñoà ñeán caùc ñieåm khoáng cheá khaùc vaø naïp toaï ñoä moät caùch töông
töï.

22- Kieåm tra sai soá xem coù chaáp nhaän ñöôïc hay khoâng. Neáu ñöôïc choïn OK ñeå keát
thuùc. AÛnh queùt seõ ñöôïc môû ra. Neáu sai soá thì kieåm tra xem sai soá vì lyù do gì, nhaép
chuoät choïn ñieåm sai vaø nhaán nuùt Edit ñeå chænh söûa laïi neáu caàn.

Khi ñaêng kyù aûnh queùt theo heä quy chieáu phi quaû ñaát vaø soá hoaù treân MapInfo theo
baûn ñoà queùt ñoù, caàn löu yù moät soá vaán ñeà sau:

- Baûn ñoà soá döïa theo aûnh queùt ñaêng kyù nhö treân chæ hieån thò ñöôïc caùc vaät theå ñöôïc
soá hoaù trong ranh giôùi cuûa aûnh queùt ñoù maø thoâi, neáu ta soá hoaù theâm nhöõng vaät theå
naèm ngoaøi aûnh queùt ñoù thì khi vöøa veõ xong chuùng seõ bò “boùp” vaøo saùt meùp cuûa aûnh
queùt vaø khoâng coøn hình daïng ñaõ veõ nöõa.

- Khi thöïc hieän tính toaùn ñòa lyù (chieàu daøi, dieän tích) trong baûn ñoà soá hoaù theo heä toaï
ñoä phi quaû ñaát, MapInfo aùp duïng caùch tính theo heä toaï ñoä Descartes phaúng hai
chieàu. Giaù trò tính toaùn ñöôïc trong MapInfo coù sai soá nhöng thöïc ra cuõng khoâng
nhieàu vì caùc baûn ñoà soá theo kieåu Non-Earth thöôøng chæ ñöôïc söû duïng trong moät
phaïm vi raát nhoû so vôùi beà maët ñòa caàu, vaø trong tröôøng hôïp ñoù maët cong ñòa caàu
gaàn nhö maët phaúng.

- Trong ví duï treân ta laáy goác toaï ñoä laø goùc treân beân traùi ñeå coù theå taän duïng caùch laáy
toïa ñoä ñieåm khoáng cheá trong Photoshop cho tieän. Veà maët nguyeân taéc, khi ñaêng kyù
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aûnh queùt theo heä toaï ñoä phi quaû ñaát, ta coù theå choïn goác toaï ñoä taïi baát kyø vò trí naøo,
thaäm chí ôû ngoaøi giôùi haïn aûnh queùt cuõng ñöôïc. Tuy nhieân neáu choïn moät goác toaï ñoä
baát kyø thì vieäc tính toaùn toaï ñoä caùc ñieåm khoáng cheá khoâng deã vaø maát thôøi gian.

- Khi queùt aûnh vaø môû aûnh ra trong Photoshop, khoaûng caùch hieån thò trong Photoshop
baèng ñuùng vôùi kích thöôùc aûnh giaáy luùc queùt vaøo, khoâng phuï thuoäc vaøo vieäc ta choïn
ñoä phaân giaûi khi queùt laø bao nhieâu.

- Ñoái vôùi moät aûnh queùt caàn ñöa vaøo MapInfo maø khoâng bieát tyû leä, neáu ñaõ coù moät baûn
ñoà soá khaùc hay moät aûnh queùt ñaõ ñaêng kyù khaùc cuûa cuøng khu vöïc, ta coù theå thöïc
hieän phöông phaùp ñaêng kyù toaï ñoä theo moät baûng MapInfo ñaõ coù. Xem chi tieát
phöông phaùp naøy trong Chöông XVII, muïc XVII.2.5.3.

III.5. CAÙCH TÍNH SAI SOÁ TRONG ÑAÊNG KYÙ AÛNH QUEÙT

Tuyø tyû leä baûn ñoà vaø  ñoä phaân giaûi cuûa aûnh queùt maø giaù trò sai soá 1 pixel treân hoäp
thoaïi Image Registration so vôùi thöïc ñòa coù theå khaùc nhau. Sai soá bao nhieâu laø chaáp
nhaän ñöôïc tuyø thuoäc vaøo yeâu caàu veà ñoä chính xaùc cuûa baûn ñoà ta caàn soá hoaù.

Muoán tính sai soá ñaêng kyù aûnh queùt baèng bao nhieâu meùt, ta caàn phaûi bieát ñöôïc ñoä
phaân giaûi cuûa aûnh queùt vaø tyû leä cuûa baûn ñoà queùt.

Ñeå bieát ñöôïc ñoä phaân giaûi cuûa aûnh queùt ta phaûi coù moät phaàn meàm xöû lyù aûnh soá
treân maùy tính thì môùi bieát ñöôïc. Phaàn naøy trình baøy caùch xem ñoä phaân giaûi aûnh queùt
töø phaàn meàm Photoshop. Caùch laøm nhö sau:

- Khôûi ñoäng Photoshop.

- Môû aûnh queùt caàn kieåm tra ñoä phaân giaûi ra.

Hình III.11. Hoäp thoaïi Image Size trong Photoshop.
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- Töø menu chính cuûa Photoshop choïn Image > Image SIze.

- Hoäp thoaïi Image Size môû ra (hình III.11), oâ Resolution cho ta bieát ñoä phaân giaûi cuûa
aûnh ñang môû. Ñôn vò tính maëc ñònh cuûa ñoä phaân giaûi laø pixels/inch, ta coù theå ñoåi veà
pixels/cm neáu muoán.

Ngoaøi ñoä phaân giaûi ta cuõng phaûi bieát ñöôïc tyû leä cuûa baûn ñoà ta ñaõ queùt thì môùi tính
ñöôïc sai soá.

Caùch tính sai soá khi ñaêng kyù aûnh queùt nhö sau:

- Goïi tyû leä baûn ñoà laø a (ví duï baûn ñoà tyû leä 1:50.000 thì a baèng 50.000 ñôn vò khoaûng
caùch, ví duï 1 cm seõ baèng 50,000 cm treân thöïc ñòa).

- Ñoä phaân giaûi cuûa baûn ñoà khi queùt laø b (pixels/ñôn vò khoaûng caùch)

- c laø heä soá quy ñoåi ñôn vò khoaûng caùch giöõa hai ñôn vò tính trong a vaø b, 
trong ñoù b = a*c (ví duï neáu a laø cm vaø b laø inch thì 1 inch = 1 cm * 2,54)

1 pixel treân aûnh queùt seõ baèng: a*c/b (ñôn vò khoaûng caùch tính theo a).

Ví duï: ta queùt moät baûn ñoà coù tyû leä laø 1/50.000 vôùi ñoä phaân giaûi laø 300 pixels/inch. Vaäy
haõy tính sai soá 1 pixel töông öùng vôùi bao nhieâu meùt ngoaøi thöïc ñòa?

Caùch tính: 
+ baûn ñoà coù tyû leä 1/50.000, vaäy 1cm treân baûn ñoà = 50.000 cm = 0,5 km thöïc ñòa.
+ ñoä phaân giaûi 300 pixels/inch, 1 inch = 2,54 cm, vaäy 300 pixel = 2,54 cm, neân 1

cm = 300/2,54 pixel.
+ 1cm = 0,5 km = 300/2,54 pixel neân 1 pixel = (0,5 x 2,54)/300 = 0,00423 km =

4,23 meùt

Nhö vaäy sai soá 1 pixel trong ví duï naøy töông öùng vôùi 4,23 meùt ngoaøi thöïc ñòa.
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